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Getting Started
Welcome to the PixMaker™ Pro application, an integrated solution that allows 
you to create interactive virtual tours in three simple steps, Snap, Stitch and Publish! 
PixMaker™ Pro delivers an environment for professionals to create high-quality 
panoramas that can be easily transformed into interactive content for viewing on 
both the Web and offline.

System requirements
The following hardware and software is required to run PixMaker Pro.

Minimum
Windows 98 Second Edition, 2000*, Millennium Edition, XP*

333 MHz Intel/AMD Processor
128 MB RAM 
50MB available hard drive space
CD-ROM drive
Video display capable of  800x600 pixels with 16 bit colors or higher
Microsoft DirectX 5.0 and above
Microsoft Internet Explorer 5.0 and above
Windows Direct Sound compatible OR Sound Blaster compatible OR EAX 
compatible sound card.
Microsoft ActiveSync+

Palm Desktop Software+

Microsoft Office 97 and above +

IEEE 1394/Firewire interface+

Optimum
Windows 98 Second Edition, 2000*, Millennium Edition, XP*

650 MHz Intel/AMD Processor
256 MB RAM 
50MB available hard drive space
CD-ROM drive
Video display capable of  1024x768 pixels with 16 bit colors or higher
Microsoft DirectX 8.0 and above
Microsoft Internet Explorer 5.0 and above
Creative Sound Blaster LIVE! Soundcard
Microsoft ActiveSync+

Palm Desktop Software+
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Microsoft Office 97 and above +

IEEE 1394/Firewire interface+

* Local administrator access required
+ Optional

Installing PixMaker Pro

You must install the PixMaker Pro application from the CD onto your hard drive 
as you cannot run the program from the CD.

Follow the steps below to install PixMaker Pro

1. Insert the PixMaker Pro CD into the computer’s CD-ROM drive.

2. Follow the on-screen instructions.

3. If  prompted, please restart your computer.

4. After the installation is complete, double-click the PixMaker Pro icon on your 
desktop. A dialog box will appear.

5. Click on “Install Key” and browse to the folder where you have stored the 
license key and select it.

Important Note:
Please retain the Master license key after installation. In the event of a system crash which requires the 
re-configuration of your system, you will need the license key to re-install PixMaker Pro.

Learning PixMaker Pro

PixAround.com provides a variety of  options for you to learn PixMaker Pro, 
including printed guides, online Help, and tool tips.

Using the User Guide

One printed User Guide is included with the PixMaker Pro package.
The User Guide provides information on using PixMaker™ Pro commands and 
features. The information provided is also available in the online Help. 
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Using online Help

The PixMaker Pro application includes complete documentation in a HTML-
based help system. The help system includes all of  the information in the 
printed User Guide.

To view the online Help topics properly, you will need Netscape Communicator 
4.0 (or higher) or Microsoft Internet Explorer 4.0 (or higher).

To start online Help:

Do one of  the following:
• From the menu, choose Help > Help.

• Press F1.

Using tool tips

The tool tips feature lets you display the name of  tools, or buttons and keyboard 
shortcuts for some commands.

To identify a tool or button:

Position the mouse over a tool or button and pause. A tool tip will appear 
showing the name and keyboard shortcut (if  any) for the item.

Online support

A list of  Frequently Asked Questions (FAQs) and trouble-shooting information 
that provides solutions to common problems are located online at PixMaker 
Pro’s web site at http://www.pixmakerpro.com/support

You can access the web site from the application itself  by doing the following:

• From the menu, choose Help > Online Support

Alternatively, if  you are not able to find the solution to your problem on 
our web site, feel free to contact the Customer Support team via email at 
support@pixaround.com or through PixMaker Pro’s web site at http://
www.pixmakerpro.com/support/form.asp
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PixMaker Pro Basics

Understanding the interface

When you launch PixMaker Pro, it will load the application with the title ‘New 
Project’ indicating that it is a new project.

The interface is illustrated as shown.
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Menu bar

The menu bar consists of  four options, namely, File, Edit, Settings and Help.

File
Under this option, you will have the following selections.
Ø New Project (Ctrl+N) – Start a new project
Ø Open Project (Ctrl+O) – Open a previously saved project
Ø Save Project (Ctrl+S) – Save the current project
Ø Save as Project – Save the current project using a different file name
Ø Page Setup – Printer setup
Ø Print Preview – Preview the current stitched image/Scene before  
 printing.
Ø Print (Ctrl+P) – Print the current stitched image/Scene.
Ø Recent Project – Open recent projects
Ø Exit – Exit PixMaker Pro

Edit
The selections available in this option vary depending on the session mode as 
indicated by the Stitcher ( ) and Hotspot tabs ( ).

In Stitcher mode, the selections available are:
Ø Undo (Ctrl+Z) – Undo the last action
Ø Select All (Ctrl+A) – Select all the images loaded
Ø Cut (Ctrl+X) – Cut the selected image(s)
Ø Paste (Ctrl+V) – Paste the selected image(s)
Ø Delete (Del) – Delete the selected image(s)
Ø Rotate (Ctrl+R) – Rotate the selected image(s) by 90 degrees
Ø Reverse Order (Ctrl+E) – Reverse the order of  all the images loaded
Ø Rotate Order (Ctrl+F) – Rotate the order of  all the images loaded
Ø Manual Align (Ctrl+M) – Align the images manually
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In Hotspot mode, the selections available are:
Ø Add Hotspot
o Scene – Link to another Scene
o Web site – Link to web site
o Audio Link – Link to audio clip
o 3D Audio Embed – Link to embedded 3D audio
o Video – Link to video
o Email – Link to email
o Text/Label – Link to label
Ø Delete Scene – Delete the current Scene
Ø Scene Properties … - Access the properties for the current Scene.

Settings
Under this option, the following selections are available:
Ø Stitching – settings that determine how the images will be stitched
Ø Viewing – settings that determine how the stitched image/Scene will  
 be displayed
Ø Lens – settings to manually adjust the lens setting
Ø Customization – settings that determines the layout of  Scenes on  
 various publishing formats

Help
Under this option, the following selections are available:
Ø Online Support – Link to web site for support information (Internet  
 connection required)
Ø Install key – Installation of  license
Ø Help – online Help system
Ø About – Version information



6 7

Buttons

Snap

This is the first button that you will click on whenever you start a new project. 
It will provide you with options to load source images from various supported 
medias.

Stitch

This is a one-touch action button that will activate the stitching process after you 
have loaded the source images and made the necessary adjustments and settings.

Publish

This button will provide options for various publishing formats after you have 
completed your project.

Maximize/Minimize

This button will maximize and minimize the panoramic viewer window. By 
default, the viewer is minimized. In the Stitcher mode, it will display the image 
list; in the Hotspot mode, it will display the Scene list.
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Toolbars

Pre-stitch
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This toolbar will be displayed whenever you have loaded images. It allows you to 
manipulate the images and define the settings for stitching.

Post-stitch
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This toolbar will be displayed after you have stitched your images. It provides 
users with options to enhance the stitched image and also to rotate it. In 
addition, it will provide information on the stitched image.

Hotspot
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This toolbar will be displayed when you switch to the Hotspot mode by clicking 
on the Hotspot tab. It provides you with the types of  Hotspots available and 
allows you to preview the Hotspot.
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Viewer windows

Image List

This viewer will display the selected source images. By selecting the individual 
images, you will be able to manipulate them using the Pre-stitch toolbar.

Scene List

This viewer will display the list of  Scenes and the Hotspots created for each 
Scene. By clicking on the individual Scene, it will be displayed in the panoramic 
viewer. Clicking on the Hotspots will cause the panoramic viewer to pan to the 
location of  the selected Hotspot.

Panoramic

This viewer displays the stitched image/Scene as it is stitched or loaded. From 
this viewer, you will be able navigate within the Scene by zooming in/out or 
panning. It is also from this viewer that you will experience the interactivity 
provided by the creation of  Hotspots.
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PixAround Content

Interactive PixAround content can be created using the following steps as a 
guideline.

Planning the project

Before you begin creating PixAround content, you will need to determine the 
type of  user experience you want to deliver to your client/audience. 

Here are some questions that you may want to ask yourself  …

What type of  images will I be using? Photographic or computer-generated (CGI)
Will the project consist of  multiple Scenes? Doing so will require you to use 
quite a number of  images.
Will the project consist of  web links that users can go for additional 
information?
Often, the decision made will involve compromising between creativity and 
limitation of  resources.

For instance, to create a virtual tour of  an apartment, you may wish to consider 
the following preliminary steps:

- Determining the number of  Scenes required based on the layout of   
 the apartment
- Reviewing each Scenes and taking note of  the location where you will  
 carry out the photo shoot to capture the images for each Scene.
- Identifying the Hotspots required for each Scene. Checking the  
 availability of  media files required for Audio and Video Hotspots.
- Determining the need of  embed or background audio for the Scenes.
- Creating a storyboard for each Scene.

Acquiring source material

Source material for Scenes can be acquired using the following:

- Film camera with the prints converted to digital form using scanners
- Digital cameras
- Analog video cameras with the video clips digitized
- Digital video cameras (No conversion required as PixMaker Pro is  
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 able to snap images directly through a USB/Firewire connection)
- 3D Rendering program (Eg. 3D Studio Max)

Depending on the type of  Scenes that you are creating, some of  them will 
require additional setups and equipment.

The techniques recommended for acquiring images for each type of  Scenes will 
be covered in the following chapters.

Assembling the project

After planning the project and acquiring the source material, you can create the 
content using the materials as planned.

Reviewing the project

Once you have created the content, you will publish it to the various desired 
formats. Review through the formats to check that the interactivity and 
experience expected is achieved. For example, a Scene Hotspot link transits to 
the destination Scene at the correct point in the source Scene.
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File types

Before we move on to learn more on the features available in PixMaker Pro. We 
shall now get to know the types of  files that we will come across.

Stitcher project
File extension: .pim

The Stitcher project (.pim) is basically a log file that tracks the image files 
that you have loaded into PixMaker Pro for stitching. It records the following 
information:

- The series of  images that you have loaded; their exact location on  
 your system.
- Image alignment made using Manual Align, if  any
- Stitch type and lens selected

Note:
The project file will not be loaded if PixMaker Pro is not able to locate the files as recorded.

Hotspot project
File extension: .piw

The function of  the Hotspot project (.piw) is similar to the Stitcher project 
except that it tracks the files that you have used to create Hotspots.

Scene

Whenever you have stitched your images together, you will need to save them 
as Scenes before you can add Hotspots to create interactive content. Once the 
stitched image has been saved, it will be known as a Scene.

Scenes can be saved in the following image formats:
- JPEG (.jpg)
- Bitmap (.bmp)
- Tagged Image File (.tif)
- Portable Network Graphics (.png)
- PixAround Image File (.pij)
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The PixAround Image File format is a proprietary format that contains 
information on the stitched image based on the settings used to stitch it. When 
you load this format into PixMaker Pro or PixScreen Lite, it will automatically 
load the Scene using the information provided. For the other formats, you will 
need to specify the Scene type and Field of  view (FOV) when you load them.

Web page

When you choose to publish to web page, a series of  files will be generated. 
The files generated are:
- License file (_psk2.ext)
- Configuration file (Default.cfg)
- Web page (.html)
- Scene files (.jpg)
- PixAround link button (pixButton.gif)
- Java Archive file (uPixScreen.jar/ObjPixScreen.jar/PixScreen.jar;  
 depending on the type of  Scenes)

All the files, except for the link button, are required for viewing the web page on 
the Internet. (If  you remove it, you will need to edit the web page to prevent it 
from loading.)

Tip:
You can use your own web page to display the PixAround content by copying the <applet></applet> tag 
from the web page generated.

Screen Saver
File extension: .scr

This is a standard screen saver format used on the Windows system. To activate 
it, you will need to set the file as the default screen saver.

Postcard
File extension: .exe

The Postcard is a self-executable file that enables the user to view interactive 
content created with PixMaker Pro on all Windows-based system without the 
use of  any plug-ins.
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Postcard Script
File extension: .pil

The Postcard Script is a customization option for Postcards that allows the user 
to retrieve additional Scenes as defined by the script via the Internet. Details on 
the script will be explained in the chapter on Customization.

Palm
File extension: .pdb

Scenes that are published using the PDA – Palm OS option will be saved with 
this extension. This file type is a standard Palm format that can only be viewed 
on Palm devices itself.

However, to view the Scene on Palm OS devices, you will need to have the 
viewer, PixScreen for PalmOS installed. For more information on this viewer, 
please refer to the chapter on PixScreen.

Windows CE
File extension: .jpg

Scenes that are published using the PDA – Windows CE option will be saved 
with this extension. This is a standard JPEG image format.

However, to view the Scene on Windows CE devices in a panoramic perspective, 
you will need to have the viewer, PixScreen Lite for Windows CE installed. For 
more information on this viewer, please refer to the chapter on PixScreen.
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Snap

Images

This option allows you to load images directly from your computer. The 
following image formats are supported:

- JPEG (.jpg)
- Bitmap (.bmp)
- PhotoCD (.pcd)
- Portable Network Graphics (.png)
- Tagged Image File (.tif)

Note:
The images must be of 24-bit color. PixMaker Pro is not able to accept images of other color formats.

In the ‘Open’ dialog box, when you click on any of  the images in the folder 
that you have browsed to, PixMaker Pro will display a thumbnail preview of  the 
image selected.
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Tip:
It is possible to load images into PixMaker Pro by dragging them onto the image list window from Windows 
Explorer.

Video

This option allows you to snap images from video clips via the ‘Video Frame 
Selection’ window. The following video formats are supported:
- AVI (.avi)
- MPEG-1 (.mpg, .mpeg)

Check out the section on photography techniques for tips on using a video 
camera to capture video for use in PixMaker Pro. 

Note:
Currently, this option does not support the creation of Object View Scenes.
 
The appropriate video codec that is used to encode the video clip must be installed on the system before 
you can use the clip in PixMaker Pro. Attempting to use a video clip without the appropriate codec installed 
will result in an error message.

Tip:
To determine whether the appropriate video codec is installed, playback the video clip using Windows 
Media Player. Windows Media Player playbacks video clips based on the video codecs installed.
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Preview Window

The preview window will display the video clip selected with general video 
playback controls.

  

The controls starting from the left are:
Play  – Start playing the video
Pause  – Pause the playback
Stop  – Stop the playback
Mark In  – Mark the first frame 
Mark Out – Mark the last frame

Tip:
If you would like to mark in from the very first frame, click on the ‘Mark In’ button without clicking on ‘Play’.
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Video Orientation

This selection is meant for users to rotate the orientation of  the video if  so 
desired.

You will be able to rotate the orientation to:
- the Left
- the Right
- 180°

Mark Frame

This window will display a thumbnail of  the first and last frame marked. If  you 
are not satisfied with the frames marked, click ‘Reset’ to mark again.

Stitch after evaluating video

This option allows PixMaker Pro to start the stitching process automatically after 
evaluating the video using the default stitch type and lens type.

Evaluating Video

After marking out the desired frames, PixMaker Pro will begin evaluating the 
video and selecting the best images based on the portion of  the video that you 
have marked.
As the evaluation is in progress, PixMaker Pro will indicate the number of  
images selected.
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Scene

This option allows you to load Scenes for the following purposes:
- Printing
- Creating interactive content by adding Hotspots
- Viewing
- Publishing to other formats

Again in the ‘Open’ dialog box, PixMaker Pro will display a thumbnail preview 
of  the selected Scene file.

Scene properties

When you choose to load a Scene that is saved in formats other than the 
PixAround Image format (.pij), you will be prompted to specify the properties 
of  the Scene.
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Scene type

Define the type of  Scene, namely:
- Cylindrical
- Flat*

- Object View
- Spherical

*Montage Scenes are considered as Flat Scenes after saving.
*Tilt Angle Scenes are considered as Spherical Scenes after saving.

Pan Range

Define the field of  view of  the Scene. If  you are not sure of  the range, select 
‘Automatic’.

Pitch Range

This value is required for the Tilt Angle Scene only. You will need to specify 
both the minimum and maximum pitch in degrees from –90° to 90°.
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Frame

This value is required for the Object View Scene to indicate the number of  
images used to create the Scene.

Note:
The Scene will appear distorted if the number of frames specified is not correct. Name your Object View 
Scene with the number of frames used (Eg. Statue18.jpg) to remember the number of frames for the 
Scene more easily.

Tip:
Save your stitched image/Scene using the PixAround Image format and you will not be required to specify 
the properties when you load it again into PixMaker Pro.

Video Devices

The function of  this option is identical to the ‘Video’ option. Instead of  marking 
frames from a video clip, however, it will allow you to mark frames directly from 
a digital video device that is available in the selection list. 

In order to use this option, you will need to install the appropriate drivers that 
will connect the video device via USB/Firewire to your system.

Note:
PixMaker Pro uses the Microsoft WDM standard to interface with video devices. If the device is not listed 
in the selection, it will indicate that the device does not have the drivers that support the WDM standard.

Acquiring source material

Before we move on to the next chapter, we shall now learn how to carry out a 
photo shoot to create source materials that you can Snap into PixMaker Pro. 

Types of Scene

In order to determine how the photo shoot should be carried out, you will need 
to know the types of  Scenes that you can create in PixMaker Pro. All Scene types 
can be 360° and Partial.

Cylindrical
Scenes projected in a cylindrical perspective. Depending on the field of  view 
(FOV), the image is warped and projected as if  you are looking from the center 
of  a cylinder. 
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Flat
Scenes projected in a flat perspective without any warping. There will not be any 
warping, as the technique used for taking images such Scenes is different from 
that of  Cylindrical Scenes.

Object View
Scenes projecting a 360° view of  a particular object from the outside in. As the 
Scenes pans, the object will rotate.

Montage
These types of  Scenes are grouped under the flat perspective. These Scenes are 
created using a series of  unrelated images to create a montage. 

Tilt Angle
Scenes projected in a spherical perspective, providing a tilted view. For example, 
taking a 360° view of  a skyline.

Photography

Carrying out a photo shoot requires you to make some preparations, including 
planning the types of  Scenes to create.

Equipment to be used

Any digital camera with the capability of  taking images with a resolution of  at 
least 800 x 600 pixels. 

Determine time and date

The time and day of  the photo shoot depends on whether are you shooting 
outdoors or indoors. For outdoors, we would recommend that you choose to do 
it on a sunny day. Postpone your photo shoot session if  you must the lighting is 
poor. It is better to get it right the first time than to do a poor job and then have 
to do it all over again.

For an indoor shoot, try to maintain the same exposure for each shot of  a 
particular Scene. Use the flash if  necessary.
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Orientation of  the camera

The camera’s orientation is dependent on the Scene that you are taking. For 
better results, position the camera in a portrait orientation as this will provide 
you with a greater field of  view.

Lenses to be used

There are various types of  lenses available in the market. Depending on the 
location of  your photo shoot, different types of  lenses may be required.

- Rectilinear lens
 Normal lenses provided on the cameras. Images taken will be exactly  
 the same without any distortion.

- Wide-angle lens
 Lens that cover a wider view than rectilinear lens in a single shot.

- Fisheye lens
 Extremely wide-angle lens that magnifies the portion of  the image  
 near the focus point and also de-magnifies the portion of  the image  
 that is away from the focus point. Currently, PixMaker Pro supports  
 the use of  semi-fisheye lens only.

Image size

PixMaker Pro is able to stitch images of  varying sizes depending on your 
system’s performance. We would suggest that you take images at a resolution of  
at least 1024 x 768 pixels so that you can use your images in a variety of  ways. 
Eg. Print, Web, e-mail etc. You can always resize the images later.

Techniques
Different types of  Scenes require different shooting techniques. The number 
of  images required depends on the percentage of  overlap between each image 
taken. We would recommend at least 10% to 20 % overlap.

- For both Cylindrical and Tilt Angle Scenes, take a series of  images  
 while in a stationary position while maintaining the camera a  
 horizontal level. Use a tripod if  possible.
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You may also use a video camera as shown.
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- For a Flat Scene, take a series of  images from left to right as shown.  
 As you take the individual images, maintain the distance between the  
 camera and the subject.

- For an Object View Scene, take a series of  images of  an object at  
 different angles as shown. You may require the use of  a turntable  
 setup to achieve good shots.

- For Montage Scenes, there are no specific techniques required. It  
 depends on your creativity instead.
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Stitch
Stitching is quite straightforward using PixMaker Pro. At the touch of  a button, 
it will start the automatic process of  alignment and stitching of  the images. 
However, before you can proceed with the stitching, you will need to specify 
both the Stitch type and Lens type. There are three optional settings. These 
settings can be accessed from the menu bar under ‘Settings’.
 
Stitch type

The Stitch type corresponds to the type of  Scene that you are creating, namely:
 Cylindrical
 Flat
 Object View
 Tilt Angle
 Montage*

The checkbox, ‘360°’, indicates whether the Scene is to be a complete 360° 
or just a partial one. Uncheck it if  the Scene is to be a partial one. If  not, the 
stitched image will be joined/wrapped from end to end.

* Images stitched using the Montage option will be grouped under Flat Scene.

Lens type

You can select from a set of  pre-defined lens provided with PixMaker Pro. If  
you are not able to find the desired settings, you can do one of  the following.

- Set the lens at ‘Auto’ and PixMaker Pro will attempt to determine the 
lens setting based on the images.
- From the menu bar, choose Settings > Lens … to specify the lens 
setting based on the images. By doing so, you will be able to save your settings 
which will allow you to select it from the drop-down list.

Note:
The Fisheye lens setting provided is meant as a template for you to create either Cylindrical or Tilt Angle 
Scenes using semi-fisheye lens. See the section on Lens Calibration for more information.
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Pre-stitch toolbar

At times, you may find that the images that you have snapped are not in the 
correct arrangement or you have left out some images. Here’s where you will 
need to use the Pre-stitch toolbar to manipulate or add images.

Using the toolbar, you will be able to:

 Add images (Insert)

 Delete images (Delete)

 Select all images (Ctrl+A) 

 Rotate selected images (Ctrl+R)

 Reverse the order of  the images (Ctrl+E)

 Rotate the order of  the image (Ctrl+F)

 Undo the last action (Ctrl+Z)

 Cut the selected images (Ctrl+X)

 Paste the selected images (Ctrl+V)

 Manual Align (Ctrl+M)

Tips:
You can re-arrange the images by drag-and-drop.
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Settings

Stitching

This setting will affect how the images will be stitched.

Source Image
This selection allows you to stitch the images at a reduced size of  either 50% or 
25%. It is extremely useful when you need to have the Scene at a reduced size 
without changing the source images beforehand.

Sharpness
The slider bar defines the degree of  sharpening for the stitched image after 
stitching.

Montage overlap
The slider bar is enabled only when the Stitch type is set as ‘Montage’. It 
will determine the amount of  overlap between each pair of  images.

Clicking on the ‘Default’ button will reset the settings back to the 
original settings.
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Viewing

This setting determines how the stitched image or a loaded Scene will be 
displayed.

High Quality viewing
Ø Always – High quality display at all times
Ø On stop only – High quality display when stitched image is not  
 panning.
Ø Never – Normal quality at all times.

Spin/Pan
This slider bar determines the panning speed of  the stitched image. 

Zoom
Using the slider bar, you will be able to increase or decrease the rate of  zooming.

Automatic Panning
Enabling this checkbox will enable the stitched image to pan automatically after 
stitching.

Zoom to max. wide angle
Enabling this checkbox will load a Scene at the widest angle.



30 31

Lens calibration

This setting allows you create or remove customization of  lens.

Distortion Correction
The slider bar will allow you to correct the distortion factor for images taken 
with wide-angle, zoom or semi-fisheye lens.

Tips:
For images taken with wide-angle lens, the value will be negative whereas for images taken with zoom 
lens, the value will be positive.

Field of  View (FOV)
The slider bar allows you to adjust the field of  view of  the Scene.

Tilt Angle
This slider bar will be enabled only when the Stitch type is set as ‘Tilt Angle’. It 
allows you to specify the degree of  tilt at which the images were taken.

Note:
When you are using images taken with semi-fisheye lens, you will need to set the lens type using the 
‘Fisheye’ setting provided before adjusting the values for the Distortion Correction and FOV.

In addition, you will need to specify the tilt angle when you are creating a Tilt Angle Scene using semi-
fisheye lens.
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Manual Align

Sometimes when you have stitched your image, the end result may not be 
desirable despite the fact that you have used the correct settings. For better 
results, you will need to align the images manually using the ‘Manual Align’ 
function.

To access the function, do one of  the following to launch the Manual Align 
window:

- Click on the Manual Align button on the Pre-stitch toolbar

- From the menu bar, choose Edit > Manual Align

- Use the keyboard shortcut ‘Ctrl+M’

Preview of  images
This panel will display the images in pairs with the alignment calculated by 
PixMaker Pro. To adjust the alignment between the set of  images, you will need 
to click and drag the right image, as the left image will always be the reference. 
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Tips:
When you are adjusting the alignment, use the keyboard arrow keys to fine-tune.

Selected image
This panel will display the images in sets of  three whereby the center image 
will be the one that you can re-align. The images on the left and right are for 
reference only. 

To switch between the images, do one of  the following

- Click on the buttons on both sides of  the slider bar.

- Click and drag on the slider bar.

Video Frame Selection
This panel is enabled if  the images are snapped from a video source. It allows 
you to select another frame from the video. This is useful when you find that 
the snapped image is not satisfactory. However due to the overlap requirement 
between images, the choice of  frames will be limited.

Image Enhancement
This panel allows you to enhance the selected image based on the following 
properties:

Ø Brightness/Contrast
Ø Hue/Saturation
Ø Sharpen

Zoom
This selection allows you to zoom in and zoom out to see a better view of  the 
alignment.

Blend
Enabling this checkbox will allow you to preview the alignment after stitching.

Color Correction
This checkbox determine whether the pair of  images currently displayed will be 
color corrected.
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Tips:
Color correction sometimes produces unnatural colors in the stitched image. To overcome this problem, 
disable the color correction for the pair of images.

Stitching progress

After you have defined the settings and made the required adjustments, click on 
the ‘Stitch’ button to start the stitching process.

The ‘Stitching in progress …’ window will appear showing the alignment and 
stitching process.

It will also provide details on the Stitch type, Lens type and Source image size. 
You can cancel the process by clicking on the ‘Cancel’ button if  you find that 
some of  the settings are incorrect. 

Post-stitch toolbar

After the stitching is completed, the stitched image will be displayed in the 
panoramic viewer. You will notice that a new toolbar has appeared. This toolbar 
allows you to perform some operations on the stitched image.

The function of  the toolbar is as follows:

 Rotate the stitched image by 90 degrees.

 Enhance the stitched image.

 View properties for the stitched image.
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Hotspots

What are Hotspots?

Hotspots are icons that you can place within Scenes. Via these icons, you will be 
able to link to various types of  media enabling you to create interactive content 
using Scenes as the main environment. 

Types of Hotspot

There are six types of  Hotspot currently available:

Scene

This Hotspot enables you to create a link from one Scene to another Scene. You 
can link to a Cylindrical Scene, Flat Scene, Object View Scene, Montage Scene or 
Tilt Angle Scene. 

Using this Hotspot, you can create a transitional effect from one Scene to 
another Scene. 

For example, you have a Scene of  a hotel’s main lobby that shows the reception 
counter and lift lobby in a distance. You can create a Scene Hotspot that links 
to a closer view of  the reception counter and lift lobby with transitional effect. 
When you click on the Hotspot that links to a closer view of  the reception 
counter, the main Scene will pan and zoom in to the direction of  the reception 
counter and load the Scene containing the close-up view of  the reception 
counter. 

You will be able to link Scenes of  the following formats:

• JPEG (.jpg)
• PixAround Image (.pij)
• Bitmap (.bmp)
• Tagged Image File (.tif)
• Portable Network Graphics (.png)
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URL

This Hotspot enables you to create a link to the URL specified. The following 
types of  URL are supported.

• HTML documents (*.htm, *.html)
• Server-side documents (*.shtm, *.shtml, *.stm)
• Active Server Pages (*.asp)
• Cold Fusion (*.cfm, *.cfml)

Tips:
By default, the URL will be loaded in the existing browser window if you are viewing the PixAround content 
from a web browser. You can set the URL to load in a new browser window by editing the HTML codes. 
Refer to chapter on PixScreen Java In-depth for details.

Audio

For the Audio Hotspot, there are two selections available. Namely, Audio link 
and 3D Audio Embed.

Audio link
This Hotspot plays back a selected audio file using the system’s default media 
player.

The following formats are supported:

• *.wav, *.wma
• *.aiff, *.aif, *.aifc
• *.au, *.snd
• *.mid, *.midi, *.rmi
• *.mp3
• *.ra, *.ram, *.rm, *.rmj

3D Audio Embed
The function of  this Hotspot differs from that of  the Audio link Hotspot as it 
will be embedded within Scenes. That is, the audio will playback seamlessly from 
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within the Scene without loading any media player, providing the user with a 3-
dimensional audio experience.

The audio being played back can be further enhanced using environment effects 
based on Creative EAX.
Currently, only wave files (.wav) are supported.

Note:
The playback of the audio depends on the audio codecs installed. For example, if you are using wave files 
encoded using non-standard codecs, ensure that the appropriate audio codecs have been installed.

Video

This Hotspot allows you to create a link to video clips that will be playback via 
the system’s default media player.

The following video formats are supported:

• Windows – *.avi, *.wmv
• MPEG –*.mpeg, *.mpg. *.m1v, *.mp2
• QuickTime –*.mov, *.qt
• Flash –*.swf
• RealMedia –*.ra, *.ram, *.rm, *.rmj

Note:
Once again the playback of the video clip depends on the video codecs installed. Therefore if you are 
using video clips encoded using non-standard codecs, ensure that the appropriate video codecs have 
been installed.

Email

This Hotspot allows you to create a link to an email address.

Label

This Hotspot is a text label that is used to highlight information on the Scene. 
To display or hide the Hotspot, click on it.
The text label is limited to 50 characters.
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Adding Hotspots

Hotspot session
Hotspots can be added easily during the Hotspot session. This session is 
accessible via the Hotspot tab ( ). 

However, Hotspots can only be added to Scenes that are saved. Therefore, when 
you attempt to switch to the Hotspot session after stitching, PixMaker Pro will 
prompt you with the following dialog box to save the stitched image.

  

In the Hotspot session, Hotspots can be added by doing one of  the following.

- Click on the button that represents the desired Hotspot on the  
 Hotspot toolbar.

- From the menu bar, choose Edit > Add Hotspot followed by your  
 choice of  the desired Hotspot.

- From within the Scene itself, right-click on the mouse and the  
 following menu will pop-up.

  

Positioning of Hotspots

You can position Hotspots anywhere within the Scene. However, by default, the 
Hotspot will be placed in the center of  the current view of  the Scene.
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The Hotspot will be placed at the position of  the mouse pointer when you using 
the ‘right-click’ method to access the Hotspot options.

Scene

When you choose to add a Scene Hotspot, the following window will be 
displayed.

Source: This panel will display the current view of  the Scene where the Hotspot 
will be positioned in the center.

Destination: This panel will display the Scene that you have chosen to link. 
Click on the drop-down list and select ‘New Scene’ to load a Scene.

Label: A description of  the Hotspot which will be displayed as tool tip when 
you mouse over the Hotspot icon in the Scene.

Tips:
In the Source Scene, pan/zoom within it to create a smooth transition effect to the Destination Scene. 

Note:
If you select a Scene that is not saved in the PixAround Image format (.pij), you will be prompted to specify 
the properties of the Scene.
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URL

When you choose to add a URL Hotspot, the following dialog box will be 
displayed.

 

URL: Enter the URL or click on ‘Browse…’ to choose a local web page.

Label: A description of  the Hotspot which will be displayed as tool tip when 
you mouse over the Hotspot icon in the Scene.

Audio link

When you choose to add an Audio link Hotspot, the following dialog box will be 
displayed.

 

Audio file: Click on ‘Browse…’ to choose an audio file.

Label: A description of  the Hotspot which will be displayed as tool tip when 
you mouse over the Hotspot icon in the Scene.

3D Audio Embed

When you choose to add a 3D Audio Embed Hotspot, the following dialog box 
will be displayed.



40 41

Audio file: Click on ‘Browse…’ to choose an audio file.

Label: A description of  the Hotspot which will be displayed as tool tip when 
you mouse over the Hotspot icon in the Scene.

Preferences: With this Hotspot, you will be able to define the following.

Ø Auto Play
 Playback the audio files automatically when the Scene is loaded.

Ø Loop
 Continuous playback of  the audio file.

Ø 3D
 Playback of  the audio file with 3D positional effect

Ø Volume
 Adjust the volume of  the playback from a value of  1 to 10.

Environmental effect for current Scene: Click on the ‘Effects’ button to select 
an environment effect for the current Scene.
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Note:
The 3D Audio Embed Hotspot is not supported on web pages.

Video

When you choose to add a Video Hotspot, the following dialog box will 
be displayed.

Video file: Click on ‘Browse…’ to choose a video file.

Label: A description of  the Hotspot which will be displayed as tool tip when 
you mouse over the Hotspot icon in the Scene.

Email

When you choose to add an Email Hotspot, the following dialog box will be 
displayed.
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Email to: Enter a valid email address.

Label: A description of  the Hotspot which will be displayed as tool tip when 
you mouse over the Hotspot icon in the Scene.

Label

When you choose to add a Label Hotspot, the following dialog box will be 
displayed.

Text: A description which will be displayed as tool tip when you mouse 
over the Hotspot icon in the Scene. When you click on the Hotspot, 
the label will be displayed permanently in the Scene until you click on it 
again.
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Reviewing Hotspots

After you have created a Hotspot, you can preview it by switching to the Preview 
mode.

To switch to the Preview mode, do one of  the following.

- Click on the  button on the Hotspot toolbar.

- Toggle the keyboard shortcut (F5)

Depending on the type of  Hotspot you have created, you can now see how 
the Hotspot function will function. This is useful especially for observing the 
transitional effect in Scene Hotspots.

To switch back to Edit mode, do one of  the following:

- Click on the  button on the Hotspot toolbar.

- Toggle the keyboard shortcut (F5)

Editing Hotspots

You can edit or delete Hotspots in the Edit mode by doing one of  the following.

- From the Scene list, right-click on the Hotspot label and select  
 either ‘Delete Hotspot’ to delete the selected Hotspot or ‘Hotspot  
 Properties…’ to edit.

- From the Scene itself, right-click on the Hotspot and select either  
 ‘Delete Hotspot’ to delete the selected Hotspot or ‘Hotspot   
 Properties…’ to edit it.

Scene properties

Now that you have learned the functions and properties of  the Hotspots 
available, we shall now touch on the properties of  a Scene.
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Every Scene has its own set of  properties that can be accessed by doing one of  
the following.

- From the Scene list, right-click on the Scene which is represented by 
the file name and select ‘Scene Properties…’.

- From the Scene itself, right-click and select ‘Scene Properties…’.

The following dialog box will be displayed.

This dialog box consists of  three tabs, General, Environmental Effects and 
Background Audio.

General

Type: Indicates the Scene type. If  you have loaded the Scene as a wrong Scene 
type, click on the ‘More’ button to change it.

Title: Indicates the label for the Scene. By default, it is the same as the file name.

File: Indicates the location of  the Scene.

Story: Caption for each Scene that will be displayed as you move from Scene to 
Scene.

Environmental Effects
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As covered in the section on the 3D Audio Embed Hotspot, this property will 
allow you to define an environmental effect for the Scene.

Background Audio

This property allows you to define the background sound for the Scene with 
options for volume and playback.

Audio file: Click on ‘Browse…’ to choose a midi audio file (.mid).

Note:
The Background Audio is not supported on web pages.

Hotspot project

After you have created your Hotspots, it is always a good practice to save the 
session as a Hotspot project so that you can edit it again after publishing.

The Hotspot project is similar to the Stitcher project where it will track 
the files that you have used as Scenes and Hotspots together with the 
information entered.
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Publish
Now we have come to the final step, publishing in PixMaker Pro. In this chapter, 
you will learn the different publish options available. Each option has its own 
requirements and properties.

Note:
Before you proceed to publish your stitched image, you will have to save it as a 
Scene before you can select any of the options available.

Scene

This option allows you to re-publish your Scene in one of  the supported 
image formats, with the option to add a logo onto the Scene based on the 
customization settings. The customization settings will be covered in details in 
the next chapter.
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The image formats supported are:

Ø JPEG (.jpg)
Ø PixAround Image (.pij)
Ø Bitmap (.bmp)
Ø Tagged Image File (.tif)
Ø Portable Network Graphics (.png)

In addition, the following image options are available:

Size
• Actual 
• Reduce to 70%
• Reduce to 50%
• Optimize for web 

Quality
Value of  1 to 100.

Note:
You will be able to change the image quality for both the JPEG and PixAround Image formats only.
The ‘optimize for web’ image option will publish the Scene at a size of less than one million pixels.

Web page

This option allows you to publish the interactive content (Scenes & Hotspots) in 
the form of  a web page.

For your convenience, there will be three templates available for selection.

  
Simple  Clean  Fun
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After selecting the template, the following dialog box will be displayed.

From the dialog box, you will be able to enter the headings and text as per the 
layout of  the web page shown.

Heading1: This will be the text that will appear on the first line of  the web page 
above the displayed Scene. 

Heading2: This is the sub-heading.

Body Text: Enter an introduction that will be displayed below the Scene 
displayed.

For the headings and body text, you can specify the font and color.

Background Color: Specify a background color for the web page.

PixAround Scene: Specify the display size of  the Scene on the web page.

Auto Pan: This checkbox determines whether the Scene will automatically pan 
when loaded.

After entering the description, you can preview the web page by clicking on the 
‘Preview’ button.
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Complete the publishing process by entering the file name for the web page in 
the next dialog box that appears. A summary of  the files generated will then be 
displayed.

Tips:
When you are creating multiple web pages containing different Scenes and Hotspots, ensure that you 
choose a different folder for each web page to prevent files from being overwritten accidentally.

Note:
If you have created 3D Audio Embed, they will be disabled when you publish to web page, as they are 
currently not supported.

Postcard

This option allows you to publish your interactive content in the form of  a 
self-executable postcard that can be distributed easily. This is one of  the special 
features available using PixMaker Pro. It allows you to provide interactive 
content that can be viewed by others without the need for plug-ins or programs. 
The Postcard comes in two forms, a general one and a customized one.

A layout of  the postcard as shown will be displayed. 

 

Depending on the type of  Postcard selected, you will be able specify the 
following:

Ø Story panel – For editing of  the Scene Story
Ø Font type – For the Scene Story and customized description
Ø Background color
Ø Customized description – Click on the ‘Customize’ button to  
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 change the description.
Ø Audio Compression – This checkbox is enabled only when  
 3D Audio Embed Hotspots are present. It will convert the   
 audio files selected using the GSM audio codec which will reduce the  
 file size of  the Postcard.

To preview the Postcard, click on the ‘Preview’ button. 

Complete the publishing process by entering the file name for the Postcard 
in the next dialog box. Image options are available to allow you to change the 
image size so as to reduce its file size.

Note:
Scenes of formats other than JPEG and PixAround Image will be converted automatically to JPEG when 
publishing to Postcard.

Screen Saver

This option will allow you to publish Cylindrical Scenes to a Screen Saver. 
Similar to publishing as a Scene, you will be able to add a logo onto the Scene 
using the customization settings that will be displayed on the Screen Saver.

Image options for size and quality are available for the Screen Saver.

The Screen Saver will have the following setting.
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ActiveX

This option will allow you to publish Scenes for viewing in Microsoft 
PowerPoint for presentation purpose. 

Image options are available to allow you to change the image size so as to reduce 
its file size.

Note:
To use this option, Microsoft Office 97 & above must be installed on the system.

The files created will only be viewable on system where PixMaker Pro 
is installed. To view the files on other systems, you will need to save 
them using the “Packed” option which will create a self-executable file 
containing the files necessary for viewing on systems without PixMaker 
Pro. Users will just have to run the self-executable file, which will launch 
the application.
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Print

This option allows you to publish Scenes as a panoramic print.

The following choices will be available.

Ø Current view of  Scene
Ø Full Scene on a single page
Ø Full Scene on multiple pages

You can preview the printout by choosing File > Print Preview from the menu 
bar.

Tips:
Depending on the actual size of the Scene, change the page orientation to landscape to optimize the 
usage of paper.
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PDA

This option will allow you to publish Scenes directly onto PDAs, enabling you 
to view Scenes on the move using the respective PixScreen viewers for the 
supported devices. The Scenes will be transferred seamlessly to the devices upon 
synchronization.

There are two types of  devices supported, namely Palm OS based devices and 
Windows CE based devices.

Palm OS

Currently, you will be able to publish the following types of  Scenes onto Palm 
OS devices.

- Cylindrical
- Flat
- Object View
- Montage

They will be converted to a different category of  Scene types when viewed using 
PixScreen for PalmOS on the devices as shown in the table below.

Scene type in 
PixMaker Pro

Cylindrical 
(360°)

Cylindrical 
(non-360°) Flat Object View Montage

Scene type in 
PixScreen for 
PalmOS

360 Part Flat Obj Flat

In addition, you will able to specify the view type and color depth depending on 
the Scene type.

Scene type 360 Part Flat Obj

View type (2D/3D) 2D/3D 2D 2D 2D

Color depth (2D/3D) 256/64K 256/64K 256/64K 256/64K
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Each Scene type option will result in a format of  different color depth and file 
size depending on the size of  the Scene and color depth selected. For a 256 
colors selection, the file size may be as large as 400Kbytes. In comparison, a 64K 
colors selection may result in a file size that can be as large as 800K.

The 64K colors selection will display the Scene in grayscale only on 8-bit devices.

   
Scene viewed on a color device.  Scene viewed on a grayscale device.

Windows CE

Scenes are published to Windows CE devices in the JPEG image format. 
Currently, only 360° Cylindrical Scenes can be used for publishing.

During publishing, you will prompted choose the image quality and preferred 
size of  the JPEG file. The better the quality and the bigger the image size, 
the larger the file size. You may want to experiment and play around with the 
options to obtain the desired configuration (balance between both quality and 
size). 
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Viewing of  Scenes on Windows CE devices is dependent on the program 
memory available on the devices. A larger image will require more program 
memory for viewing. Therefore, to aid users on choosing the appropriate image 
quality and size, the estimated amount of  free program memory required will be 
displayed.

Customization
After we have covered the steps required to create interactive content. We shall 
now move on to a powerful feature in PixMaker Pro, Customization.

Using the customization settings, you will be able to define how your content 
will be displayed on web pages, postcards and screen savers.

To access the customization settings, choose Settings > Customization from the 
menu bar. The dialog box as shown will be displayed.
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Settings

This settings selection allows you create multiple customization settings for 
different purposes. A default setting will be provided for reference.

Creating new setting

To create a new setting, click on the ‘Save As’ button and enter a name for the 
setting in the dialog box displayed.

Deleting settings

Alternatively, to remove settings, select it from the drop-down list and click on 
‘Delete’ to delete.

Note:
As the default setting is for reference, it cannot be deleted.

The Customization Settings is divided into five tabs, namely Postcard, Scene, 
Screen Saver, Screen Viewer and Client License.

Each tab provides customization settings for all the publishing options except 
the PDA and Print options.
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Note that these settings will affect the publishing options differently depending 
on the status of  the checkbox ‘Use customized settings’ on the ‘Publish’ menu.

Postcard

Settings on this tab will determine the links and information on Postcards. All 
the settings will not be enabled if  the ‘use customized settings’ checkbox is not 
checked except for the “View More” Link. This will be enabled for both types 
of  Postcard.

Logo

• Image formats supported
 Ø JPEG (.jpg)
 Ø Bitmap (.bmp)
 Ø Icon (.ico)
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• Size
 Ø 88 pixels by 32 pixels

Logo link

The URL is not editable as it is based on the license information provided by the 
license key.

Image

• Image formats supported
 Ø JPEG (.jpg)
 Ø Bitmap (.bmp)
 Ø Icon (.ico)

• Size
 Ø 88 pixels by 104 pixels

Image Link

This link will load the URL specified in a web browser window when you click 
on the image.

Note:
For both the Logo and Image, the preview on the left will display it in a reduced size. However if the size 
of the logo selected exceeds the required size, it will be cropped automatically when you publish the 
postcard. 

Name

Enter a description that can be a name of  a person or company.

Email

Enter an email address.
When a user clicks on the email address on the Postcard, it will launch the 
default email client with attention to the email address stated.

Contact

Enter a contact number
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“View More” link

This is a special URL which requires an Internet connection. When you click 
on it, it will retrieve and display a selection of  Scenes based on the information 
contained in the Postcard Script file (.pil).

  

Postcard Script file

Using the script file as specified, you will able to view additional Scenes via the 
Postcard based on the information provided in the script file.

The format of  the script file is as follows:

Header

CYL ‘name’ ‘title’  ‘filename’  ‘yawRange’  ‘startYaw’  ‘startPitch’  ‘startFov’ 
‘story’

FLT ‘name’ ‘title’  ‘filename’  ‘yawRange’  ‘startYaw’  ‘startPitch’  ‘startFov’ ‘story’

OBV ‘name’ ‘title’  ‘filename’  ‘yawRange’  ‘numOfFrames’  ‘defaultFrame’  
‘autoPanSpeed’ ‘story’

Where
- Header is set as ‘PixAround List 2.0’
- CYL refers to Cylindrical Scenes
- FLT refers to Flat Scenes
- OBV refers to Object View Scenes
- name refers to the name of  the Scene
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- title refers to the title of  the Scene as shown in the applet in quotes.
- filename refers to the URL of  the Scene.
- yawRange refers to the total yaw angle of  the Scene, which determines  
 whether the Scene is 360° or non-360.
- startYaw refers to the horizontal starting point of  the Scene
- startPitch refers to the vertical starting point of  the Scene
- startFov refers to the vertical field of  view when the Scene is loaded
- numOfFrames refers to the total number of  images used to create the  
 Object View Scene.
- defaultFrame refers to starting frame of  the Object View Scene when  
 the Scene is loaded.
- autoPanSpeed refers to the panning speed of  the Object View Scene.
- story refers to the URL of  a text file that describes the Scene. 

For the Postcard to retrieve and display the Scenes specified in the script, you 
will need to upload the following files to the URL specified under the “View 
More” Link.

- Postcard Script file (.pil)
- Scenes (.jpg)
- Description text (.txt)

Example

PixAround List 2.0

CYL  ‘KohSamui’  KohSamui’  ‘http://image.pixaround.com.sg/media/
kohsamuismall.jpg’  360.0  118.0  65.0  2.0  ‘http://image.pixaround.com.sg/txt/
KohSamui.txt’

CYL  ‘Mumbai’  Mumbai’  ‘http://image.pixaround.com.sg/media/
mumbai002small.jpg’  360.0  2.0  66.0  28.0  ‘http://image.pixaround.com.sg/
txt/Mumbai.txt’
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Scene

Settings on this tab will affect how the Scene will be published.

Logo

This logo will be placed on top of  the Scene based on the position specified 
when publishing using customized setting.

• Image formats supported
 Ø JPEG (.jpg)
 Ø Bitmap (.bmp)
 Ø Icon (.ico)

• Size
 Ø Maximum size of  200 pixels by 200 pixels

Position

• Top Left
• Top Right
• Bottom Left
• Bottom Right
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Screen Saver

Settings on this tab will affect how the Screen Saver will be published.

Logo

This logo will be placed on top of  the Screen Saver based on the position 
specified when publishing using customized setting.

• Image formats supported
 Ø JPEG (.jpg)
 Ø Bitmap (.bmp)
 Ø Icon (.ico)

• Size
 Ø Maximum size of  200 pixels by 200 pixels

Position

• Top Left
• Top Right
• Bottom Left
• Bottom Right

Background Image

This image will be displayed when the Screen Saver is loading
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• Image formats supported
 Ø JPEG (.jpg)
 Ø Bitmap (.bmp)
 Ø Icon (.ico)

• Size
 Ø 64 pixels by 64 pixels

Screen Viewer

Settings on this tab will affect the interface of  the viewer display in your Scenes 
for both web pages and Postcards.

Hotspot icon
This icon defines the Hotspot icon in various states, namely:

- Up state (When it is not clicked on)

- Down state (When it is clicked on)

- Masking for Up state

- Masking for Down state

• Image formats supported
 Ø Bitmap (.bmp)

• Size
 Ø 24 pixels by 96 pixels
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URL Link icon
This is the icon that will be displayed on the navigation bar as shown.

• Image formats supported
 Ø Bitmap (.bmp)

• Size
 Ø 16 pixels by 16 pixels

URL Link on Navigation Bar
This is the URL link for the icon.
It will load the URL specified in a web browser window when it is clicked on.

Background Image
This image will be displayed when the Screen Saver is loading

• Image formats supported
 Ø JPEG (.jpg)

• Size
 Ø 64 pixels by 64 pixels

Licensed by

The information stated is based on the license key installed.
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Client License

This tab will display information based on the Master license key installed and 
allows you to specify a client license key.

This feature is meant for users who have purchased client licenses. 

Note that once a client license key has been specified, all the settings will reflect 
the client license information.
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PixScreen Java in-depth

Introduction

Scenes on web pages are viewed using Java applets. When you choose to publish 
to web page using PixMaker Pro, it will automatically generate the necessary 
parameters for the Java applet using default settings. The applet is stored in a 
Java Archive file (.jar). The Java applet can be customized using the available 
parameters and methods. 

Most of  the parameters have default settings, if  they are not specified, the 
default settings will remain. Some of  the Elements are common, whereas others 
are specifically used for a particular applet. 

Methods are additional functions used to enhance the applet. Methods are used 
in JavaScript and hyperlink definitions

At times, you may find that the default settings are inadequate. Therefore it will 
necessary for you to learn how to change the settings in this chapter

Which applet (.jar) to use?

There are three applets available in PixMaker Pro, namely PixScreen.jar, 
uPixScreen.jar and ObjPixScreen.jar. 

PixScreen.jar is the primary applet, whereas uPixScreen.jar and ObjPixScreen.jar 
are secondary applets. PixScreen.jar has all the features whereas uPixScreen.jar 
and ObjPixScreen.jar have limited features. 

Usage of  the applets is dependent on the type of  Scenes and presence of  
Hotspots.

Applet Features

PixScreen.jar Cylindrical/Flat/Object View/Tilt Angle Scenes, Hotspots, TransitTo() method & 
SetTitle() method

uPixScreen.jar Cylindrical Scenes, TransitTo() method & SetTitle() method

ObjPixScreen.jar Object View Scenes & SetTitle() method



66 67

<applet></applet>

<name>

Under the HTML specification, every applet definition will have a name to 
it. It can be any alphanumerical value that you want. PixMaker Pro publishes 
webpages with the applet named as “Template1” by default.

Syntax
<applet name=”alphanumerical”>
 
Example
<applet name=”Template1”>

<code>

This attribute specifies the name of  the class file that contains the compiled 
applet. The value will be the same as the Java Archive file except that it has a 
extension of  .class instead of  .jar

Syntax
<applet code=”PixScreen.class”>
<applet code=”uPixScreen.class”>
<applet code=”ObjPixScreen.class”>

Example
<applet name=”Template1” code=”uPixScreen.class”>

<archive>

This attribute specifies the name of  the Java Archive file. 

Syntax
<applet archive=”PixScreen.jar”>
<applet archive=”uPixScreen.jar”>
<applet archive=”ObjPixScreen.jar”>

Example
<applet name=”Template1” code=”uPixScreen.class” archive=”uPixScreen.jar
”>
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<width>

This attribute specifies the display width of  the Java applet in pixels. The width 
of  the applet is set at 400 pixels by default in PixMaker™ Pro.

Syntax
<applet width=numerical>

Example
<applet name=”Template1” code=”uPixScreen.class” archive=”uPixScreen.jar” 
width=400>

<height>

This attribute specifies the display height of  the Java applet in pixels. The height 
of  the applet is set at 150 pixels by default in PixMaker Pro.

Syntax
<applet height=numerical>

Example
<applet name=”Template1” code=”uPixScreen.class” archive=”uPixScreen.jar” 
width=400 height=150>

<codebase>

The codebase attribute specifies the URL location of  the files required to load the 
applet. If  this attribute is not specified, the web browser will assumed that files 
are located in the same directory as the HTML file itself.

Syntax
<applet codebase=”URI”>

Example
<applet name=”Template1” code=”uPixScreen.class” archive=”uPixScreen.jar” 
width=400 height=150 codebase=”http://www.pixaround.com/java/”>

The codebase indicates that the .class and .jar files are located under the 
URL http://www.pixaround.com, in the sub folder ‘Java’.
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<param name>

<url> or <scene>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter specifies the filename of  the Scene that is published. In 
PixMaker Pro, when you publish to HTML, the Scene will be named as 
‘memoryimage.jpg’ by default. This parameter is used for single Scenes only. In 
PixScreen.jar, it is replaced by the parameter world.

Syntax
<param name=url value=”alphanumerical”>

Example
<param name=url value=”memoryimage.jpg”>

<world>

Supported Applets
uPixScreen.jar ObjPixScreen.jar X PixScreen.jar

This parameter replaces the parameter url used in both ‘uPixScreen.jar’ and 
‘ObjPixScreen.jar’. It defines all the properties of  the Scenes and Hotspots 
within the web page.

Syntax
<param name=world value=”
 { cyl name title filename yawRange startYaw startPitch 
startFov story

{ sce name label filename yaw pitch AutoSpinOnDestinat
ionLoaded srcYaw  srcPitch srcFov  destYaw destPitch 
destFov }

{ url name label url yaw pitch 0/1 }
{ aud   name label url yaw pitch 0/1 }
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{ vid name label url yaw pitch 0/1 }
{ eml name label url yaw pitch 0/1 }
{ lbl name label url yaw pitch 0/1 }

 }

 { flt name title filename yawRange startYaw startPitch 
 startFov story }

 { obv name title filename yawRange numOfFrames 
 defaultFrame AutoPanSpeed story }

 { sph  name title filename yawRange minPitchRange 
 maxPitchRange startYaw startPitch startFov story }

 “>

Where 

{cyl} refers to definition for Cylindrical Scenes
{flt} refers to definition for Flat Scenes
{sph} refers to definition for Tilt Angle Scenes

- name refers to the name of  the Scene. PixMaker Pro names it as the  
 filename of  the Scene without the file extension.
- title refers to the title of  the Scene as shown in the applet in quotes.  
 PixMaker Pro sets it as the same as name.
- filename refers to the file name of  the Scene.
- yawRange refers to the total yaw angle of  the Scene, which determines  
 whether the Scene is 360° or non-360°.
- minPitchRange refers to the minimum pitch angle for Tilt Angle Scene.
- maxPitchRange refers to the maximum pitch angle for Tilt Angle Scene.
- startYaw refers to the horizontal starting point of  the Scene
- startPitch refers to the vertical starting point of  the Scene
- startFov refers to the vertical field of  view when the Scene is loaded
- story refers to the description of  the Scene which is used by the  
 Cbard.class for visual narration. If  the story is lengthy, break them  
 down into a few lines by adding ‘\n’ after the last letter of  the line. It  
 is nil by default. 
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{obv} refers to definition for Object View Scenes

- name refers to the name of  the Scene. PixMaker Pro names it as the  
 filename of  the Scene without the file extension in quotes.
- title refers to the title of  the Scene as shown in the applet in quotes.  
 PixMaker Pro sets it as the same as name.
- filename refers to the file name of  the Scene.
- yawRange refers to the total yaw angle of  the Scene, which determines  
 whether the Scene is 360° or non-360°.
- numOfFrames refers to the total number of  images used to create the  
 Object View Scene.
- defaultFrame refers to the starting frame of  the Object View Scene  
 upon loading. PixMaker Pro sets it as the first image used in creating  
 the Object View Scene.
- autoPanSpeed refers to the panning speed of  the Object View Scene.  
 PixMaker Pro sets the speed at ‘10’.
- story refers to the description of  the Scene which is used by the  
 Cbard.class for visual narration. If  the story is lengthy, break them  
 down into a few lines by adding ‘\n’ after the last letter of  the line. It  
 is nil by default.

{sce}, {url}, {aud}, {vid}, {eml} & {lbl} refers to definition for 
Hotspots within Scenes.

Hotspot Naming 
convention used 
by PixMaker Pro

Example

Scene 
(SCE)

‘Scene_’ + file 
name

ibp.jpg as ‘Go to Scene_ibp’

URL 
(URL)

‘URL_’ + URL http://www.pixaround.com as ‘URL:Go to Website_http://
www.pixaround.com’

Audio 
(AUD)

‘Audio_’ + file name water.wav as ‘Audio:Play Audio_water’

Video 
(VID)

‘Video_’ + file name PixLogo.mpg as ‘Video:Play Video_PixLogo’

Email 
(EML)

‘Email_’ + email 
address

support@pixaround.com as ‘Email:Send to Email_
support@pixaround.com’

Label 
(LBL)

‘Label_Text’ Welcome as ‘Label:Welcome’
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- name refers to the name of  the Hotspot. PixMaker Pro names the  
 Hotspot based on the type of  Hotspot used and its file name. The  
 naming convention is as shown below.
- label refers to the description of  the Hotspot when highlighted.  
 PixMaker Pro describes it based on the type of  Hotspot and its file  
 name. The naming convention is as shown below.
- url refers to the file name of  the Hotspot.
- filename refers to the file name of  the destination Scene for Scene  
 Hotspot.
- yaw refers to the horizontal position of  the Hotspot within the Scene.
- pitch refers to the vertical position of  the Hotspot within the Scene.
- 0/1 defines how the Hotspot be should be activated. A value of  ‘0’  
 will activate the Hotspot within the same window, whereas a value of   
 ‘1’ will activate the Hotspot in a new window.
- autoSpinOnDestinationLoaded defines whether the Scene should auto  
 spin upon loading.
- srcYaw refers to the horizontal position that the present Scene should  
 pan to when the Hotspot is clicked on.
- srcPitch refers to the vertical position that the present Scene should pan  
 to when the Hotspot is clicked on.
- srcFov refers to the horizontal field of  view of  the Scene when the  
 Hotspot is clicked on. 
- destYaw refers to the horizontal position that the new Scene should  
 pan to when loaded.
- destPitch refers to the vertical position that the new Scene should pan  
 to when loaded.
- destFov refers to the horizontal field of  view of  the new Scene when  
 loaded.

For Scene Hotspots, you will need to define the properties of  the Scene. 
Different type of  Scenes is defined using different definitions. For Cylindrical 
Scenes, you will use the {cyl} definition. For Flat Scenes, you will use the {flt} 
definition. For Object View Scenes, you will use the {obv} definition. For Tilt 
Angle Scenes, you will use the {sph} definition.
Examples

<param name=world value=”
               { cyl   ‘ibp’   ‘ibp’   ‘ibp.jpg’   360   0 0 180   ‘This is the IBP.’                  
 { sce   ‘Scene_lobby’   ‘Go to Scene_lobby’   ‘lobby.jpg’   1.38 0   1    
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 1.38 0 74.54   0 0 180 }                  
 { url   ‘URL_http://www.pixaround.com’   ‘URL:Go to Website_http: 
 //www.pixaround.com’   ‘http://www.pixaround.com’   46.52 0   0 }                  
 { aud   ‘Audio_water’   ‘Audio:Play Audio_water’   ‘water.wav’   91.32 0    
 0 }                  
 { vid   ‘Video_PixLogo’   ‘Video:Play Video_PixLogo’     
 ‘PixLogo.mpg’   136.13 0   0 }                  
 { eml   ‘Email_support@pixaround.com’   ‘Email:Send to Email_ 
 support@pixaround.com’   ‘mailto:support@pixaround.com’   180.86  
 0   0 }                  
 { lbl   ‘Label_Text’   ‘Label:WELCOME’   ‘Text’   225.61 0   0 }                 
 }
 { cyl   ‘lobby’   ‘lobby’   ‘lobby.jpg’   360   0 0 180   ‘This is the lobby.\ 
 nPlease feel free to look around.’              }               
“ >

This Scene consists of  all the Hotspots available in PixMaker Pro. Notice that 
there is an additional {cyl} definition for the Scene Hotspot.

<speed>

Supported Applets
uPixScreen.jar ObjPixScreen.jar X PixScreen.jar

This parameter controls the speed of  movement when the user pans, tilt or 
zoom the scene using the mouse on the Scene or the navigation tool bar. By 
default, the value is ‘1’.

Syntax
<param name=speed value=numerical>

Example
<param name=speed value=2>
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<numFrames>

Supported Applets
uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the total number of  frames for an Object View Scene. 
This value is equal to the number of  images used to stitch the object view scene. 
PixMaker Pro sets the value according to the total numbers of  images used.

Syntax
<param name=numFrames value=numerical>

Example
<param name=numFrames value=11>

The Object View Scene consists of  11 frames.

<startFrame>

Supported Applets
uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the start frame of  the Object View Scene. By default, 
PixMaker Pro will set the start frame at the first frame. 

Syntax
<param name=startFrame value=numerical>

Example
<param name=startFrame value=3>

Start the Object View Scene at the 3rd frame.
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<restrictSize>

Supported Applets
uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter will determine whether the image size of  the Object View Scene 
is restricted proportionally to less than 1 million pixels to cater to viewing on all 
browsers. Netscape browsers 4.7 & below are not unable to load images with 
width greater than 4080 pixels and also images with a total pixel count of  more 
than 1 million pixels. By default, the value is “yes”.
 
Syntax
<param name=restrictSize value=”yes/no”>

Example
<param name=restrictSize value=”yes”>

Restrict the image size of  the Object View Scene.

Note:
It will not be advisable to disable the restriction unless the web pages will be viewed on non-Netscape 
browsers only. 

<startYaw>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the horizontal start point of  the Scene. The value ranges 
from ‘0’ to ‘360’ depending on the type of  Scene. If  it is a 360° Scene, the 
maximum value will be ‘360’, else the value will depend on the total field of  view 
of  the Scene. 

Syntax
<param name=startYaw value=numerical>

Example
<param name=startYaw value=0>
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<startPitch>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the vertical position of  the Scene within the applet. The 
definition will only be effective under the following two conditions. One, the 
applet’s value for the height and width is smaller than the Scene’s width and 
height. Two, the starting field of  view (startFov) defined is less than ‘80’. By 
default, PixMaker Pro will set the startPitch at ‘0’, which will centralize the Scene 
within the applet. The value can be either ‘positive’ or ‘negative’. If  the value is 
positive, it will position the Scene upwards, whereas if  the value is negative, it 
will position the Scene downwards.

Syntax
<param name=startPitch value=numerical>

Example
<param name=startPitch value=0>

<startFov>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the horizontal starting field of  view for the Scene. The 
field of  view refers to the horizontal area that you can see when the Scene is 
loaded. For a maximum starting field of  view, set the value at ‘180’. By default, 
PixMaker Pro will set the startFov at ‘180’. The range of  the value is dependent 
on the Scene itself.

Syntax
<param name=startFov value=numerical>

Example
<param name=startFov value=180>
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<partialStitch>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the type of  Scene that is being viewed. For non-360° 
Scenes, the value will be ‘yes’, else the value will be ‘no’. If  the value is ‘yes’, the 
parameter horFov must be specified. PixMaker Pro sets the value according to the 
type of  Scene created. 

Note:
For Cylindrical Scenes, if the value is set as ‘no’ but the value of the paramter horFov is not ‘360’. The 
Scene will be displayed as a non-360° Scene based on the value of the parameter horFov.

Syntax
<param name=partialStitch value=”yes/no”>

Example
<param name=partialStitch value=”yes”>

<horFov> or <yawRangeDeg>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the horizontal total field of  view for the Scene. The field 
of  view refers to the total horizontal area that you can see as the Scene auto 
spins. By default, PixMaker Pro sets the value according to the type of  Scenes. 
For 360° Scenes, the value will be ‘360’, as for non-360° Scenes, the value will be 
calculated based on the total number of  images used to create the Scene.

Syntax
<param name=horFov value=numerical>

Example
<param name=horFov value=360> 
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<autoPan>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines whether the Scene will auto pan on loading. If  the value 
is ‘yes’, the Scene will auto pan, else if  the value is ‘no’; the Scene will not auto 
pan.

Syntax
<param name=autoPan value=”yes/no”>

Example
<param name=autoPan value=”yes”>

<autoPanSpeed>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the speed at which the Scene auto pans. By default, 
PixMaker Pro sets the Scene to auto pan upon loading with a speed value of  
‘10’. The speed can be adjusted according to your own preference. The higher 
the value, the faster it will auto pan.

Syntax
<param name=autoPanSpeed value=numerical>

Example
<param name=autoPanSpeed value=10>
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<autoPanDelay>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines a value that stops the auto panning momentarily. This 
means that it will auto pan and then stop between frames for a certain period 
based on the value in milliseconds. This stoppage will free up computation 
resources momentarily, which enables other objects within the HTML that uses 
computational resources to have more resources to complete computation. 
PixMaker Pro sets the value at ‘50’ milliseconds. You can set the value to ‘0’ 
if  you are sure that no other objects within the HTML require computational 
resources. Setting the value to ‘0 ‘will result in smoother auto spin especially in 
Internet Explorer.
 
Note:
Setting the value to lower values than 500 milliseconds may cause existing Netscape browsers (4.x) to 
lose windows event. (E.g. the toolbar buttons turn black)

Syntax
<param name=autoPanDelay value=milliseconds>

Example
<param name=autoPanDelay value=50>

<autoPanTimeout>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the duration of  auto pan based on the value in minutes. 
This is because prolonged auto pan will cause Netscape browsers to lose window 
event. By default, PixMaker Pro sets the value at ‘3’ minutes.

Syntax
<param name=autoPanTimeout value=minutes>
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Example
<param name=autoPanTimeout value=3>

<maxFps>

Supported Applets
X uPixScreen.jar ObjPixScreen.jar X PixScreen.jar

This parameter defines simply the maximum frames per second. It should be less 
than or equal to ‘60’. 

Syntax
<param name=maxFps value=numerical>

Example
<param name=maxFps value=60>

<hq>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the viewing quality of  the Scene in 3D view. A value 
of  ‘0’ will set the viewing quality to normal whereas a value of  ‘1’ will set the 
viewing quality to high. By default, PixMaker Pro sets the value at ‘0’.

Note:
Auto panning at normal view quality will result in a shimmering effect as the Scene pans.
But setting the viewing quality to high may result in a slow performance on slower computers (E.g. 
Pentium 100 Mhz), as high quality viewing requires more computational resources. 

Syntax
<param name=hq value=1/0>

Example
<param name=hq value=0>
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<viewType>

Supported Applets
X uPixScreen.jar ObjPixScreen.jar PixScreen.jar

This parameter defines the view type of  the Scene. A value of  ‘1’ will display the 
Scene in 3D whereas a value of  ‘0’ will display the Scene in 2D. 2D view will not 
shimmer during auto panning as less computational resource are required. From 
our experience, some people are unable to tell the difference between 2D and 
3D view, especially for outdoor scenery. Therefore, you may wish to set the view 
at 2D for some Scenes depending on the kind of  scenery.

Syntax
<param name=viewType value=1/0>

Example
<param name=viewType value=1>

<title>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar PixScreen.jar

This parameter defines the title for the Scene that is loaded. If  no value is 
defined, no title will be displayed.

Syntax
<param name=title value=”alphanumerical”>

Example
<param name=title value=”My World”>
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<titlePos>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the position of  the title within the applet itself. There are 
4 positions where you can place the title. PixMaker Pro sets the value at ‘0’ and 
this displays the title on top of  the navigation tool bar.

Syntax
<param name=titlePos value=0/1/2/3/4> 

Where 
0 position it at the bottom left corner
1 position it at the top left corner
2 position it at the top right corner
3 position it at the bottom right corner
4 position it at beside the tool bar

Example
<param name=titlePos value=0>

<titleForegroundColor>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the color of  the title text in hexadecimal format rrggbb. 
By default, PixMaker Pro sets the value at ‘FFFFFF’.

Syntax
<param name=titleForegroundColor value=rrggbb>

Example
<param name=titleForegroundColor value=ffffff>
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<titleBackgroundColor>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the color of  the title background in hexadecimal format 
rrggbb. By default, PixMaker Pro sets the value at ‘888888’.

Syntax
<param name=titleBackgroundColor value=rrggbb>

Example
<param name=titleBackgroundColor value=888888>

<titleBorderColor>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the color of  the title border in hexadecimal 
format rrggbb. By default, PixMaker Pro sets the value at ‘666666’.

Tip:
Set the value to the value of the titleBackgroundColor to turn off the border.
Syntax
<param name=titleBorderColor value=rrggbb>

Example
<param name=titleBorderColor value=666666>

<hsTransparency>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar
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This parameter defines the visual status of  Hotspots. The Hotspots can be either 
opaque or transparent. A value of  ‘0’ displays opaque Hotspots, whereas a value 
of  ‘1’ displays transparent Hotspots. By default, PixMaker Pro sets the value at 
‘1’, which displays opaque Hotspots.

Syntax
<param name=hsTransparency value=1/0>

Example
<param name=hsTransparency value=1>

<licenseFile>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter allows you to rename the license file. When it is not specified, the 
applet will assume that the license file is named as ‘_psk2.ext’.

Syntax
<param name=licenseFile value=”filename”>

Example
<param name=licenseFile value=”master.ext”>

<customizationFile>

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

This parameter defines the name of  the customization settings profile depending 
on the profile selected.

Syntax
<param name=customizationFile value=”filename”>

Example
<param name=customizationFile value=”pixaround.cfg”>
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Methods

Supported Applets
X uPixScreen.jar X ObjPixScreen.jar X PixScreen.jar

TransitTo()

Usage
To load a new Scene into the applet. In other words, replacing the existing Scene 
by displaying another Scene. There are three versions available, uPixScreen.jar 
supports two versions and PixScreen.jar supports all the versions. 

Important:
uPixScreen.jar and PixScreen.jar uses slightly different parameters.

uPixScreen

Syntax
TransitTo10(strURL, dSrcYaw, dSrcPitch, dSrcFov, dTargetYaw, dTargetPitch, 
dTargetFov, dYawRange, iAutoPan, dSpeed)

TransitTo7(strURL, dTargetYaw, dTargetPitch, dTargetFov, dYawRange, 
iAutoPan, dSpeed)
Where
- strURL refers to the filename of  the Scene in double quotes
- dSrcYaw refers to the source Yaw position to turn to
- dSrcPitch refers to the source Pitch position to turn to
- dSrcFov refers to the source vertical Field of  view 
- dTargetYaw refers to the target Yaw position to start at
- dTargetPitch refers to the target Pitch position to start at
- dTargetFov refers to the target vertical Field of  view
- dYawRange refers to the total Yaw angle
- iAutoPan refers to the auto pan status after loading
- dSpeed refers to the panning speed

The first version when executed will pan the present Scene to the position 
indicated by the values of  (dSrcYaw, dSrcPitch, dSrcFov) at the speed indicated 
by the value of  (dSpeed) and then load the Scene indicated by the value of  
(strURL) and face the position indicated by the values of  (dTargetYaw, dTargetPitch, 
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dTargetFov). The (dYawRange) indicated the total Yaw angle. For instance, if  the 
new Scene is of  360° type, the (dYawRange) value will be ‘360’. The new Scene 
will auto pan if  the value of  (iAutoPan) is ‘1’ and vice versa.

The second version when executed will load the new Scene indicated by 
(strURL) and face the position indicated by the values of  (dTargetYaw, 
dTargetPitch, dTargetFov). The new Scene will auto pan if  the value of  (iAutoPan) 
is ‘1’ and vice versa. It is similar to the first version except that it loads the new 
Scene immediately without panning.

PixScreen

Syntax
TransitTo9(strURL, dSrcYaw, dSrcPitch, dSrcFov, dTargetYaw, dTargetPitch, 
dTargetFov,  iAutoPan, dSpeed)

TransitTo6(strURL, dTargetYaw, dTargetPitch, dTargetFov, iAutoPan, dSpeed)

TransitTo(strURL, iAutoPan)

Where
- strURL refers to the filename of  the Scene in double quotes
- dSrcYaw refers to the source Yaw position to turn to
- dSrcPitch refers to the source Pitch position to turn to
- dSrcFov refers to the source vertical Field of  view 
- dTargetYaw refers to the target Yaw position to start at
- dTargetPitch refers to the target Pitch position to start at
- dTargetFov refers to the target vertical Field of  view
- iAutoPan refers to the auto pan status after loading
- dSpeed refers to the panning speed

The first version when executed will pan the present Scene to the position 
indicated by the values of  (dSrcYaw, dSrcPitch, dSrcFov) at the speed indicated by 
the value of  (dSpeed) and then load the Scene indicated by the value of  (strURL) 
and face the position indicated by the values of  (dTargetYaw, dTargetPitch, 
dTargetFov). The new Scene will auto pan if  the value of  (iAutoPan) is ‘1’ and vice 
versa.
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The second version when executed will load the new Scene indicated by 
(strURL) and face the position indicated by the values of  (dTargetYaw, 
dTargetPitch, dTargetFov). The new Scene will auto pan if  the value of  (iAutoPan) 
is ‘1’ and vice versa. It is similar to the first version except that it loads the new 
Scene immediately without panning.

The third version when executed will load the new Scene indicated by (strURL) 
immediately. The new Scene will auto pan if  the value of  (iAutoPan) is ‘1’ and 
vice versa. Of  all the versions, this version is the most convenient one; as it loads 
the Scene immediately using the default Yaw, Pitch and Field of  view. PixMaker 
Pro using this version.

Please note that the value for dYawRange is not needed, as it is already defined in 
the world parameter. This is the difference between the methods for uPixScreen 
and PixScreen.

Note:
For PixScreen, it can only load Scenes defined in the world parameter.

Examples

First Version

For uPixScreen,

<a href=”#” onClick=”document.applets[0].TransitTo10(‘lobby.jpg’, 280.0, 0.0, 
35.0, 80.0, 0.0, 80.0, 360.0, 1, 20) “)>Lobby</a>

For PixScreen,

<a href=”#” onClick=”document.applets[0].TransitTo9(‘lobby.jpg’, 280.0, 0.0, 
35.0, 80.0, 0.0, 80.0, 1, 20) “)>Lobby</a>

The source Scene will auto spin to the position (280.0,0.0,35.0) and then load the 
target Scene and start auto spin from the position (80.0,0.0,80.0). The values for 
the source and target Yaw, Pitch and FOV can be determined using PixScreen 
Lite where the values are provided in the status bar.
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Second Version

For uPixScreen,

<a href=”#” onClick=”document.applets[0].TransitTo7(‘lobby.jpg’, 80.0, 0.0, 
80.0, 360.0, 1, 20) “)>Lobby</a>

For PixScreen,

<a href=”#” onClick=”document.applets[0].TransitTo6(‘lobby.jpg’, 80.0, 0.0, 
80.0, 1, 20) “)>Lobby</a>
 
The target Scene will be loaded and start auto panning from the position 
(80.0,0.0,80.0). This version can also be used for transition within the same 
Scene, which is a good method for product showcasing.

Third Version

For PixScreen,

<a href=”#” onClick=”document.applets[0].TransitTo(‘lobby.jpg’, 
1)”)>Lobby</a>

The target Scene will be loaded immediately start auto spinning from the default 
position (0.0,0.0,80.0).

Do note that for the all the Scenes, the FOV’s value is set at ’80.0’. This is 
because the images for the Scenes have the same focal length.
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SetTitle()

Usage
To change the title within the applet when you transit to a new Scene.

Syntax
SetTitle(strTitle, iPos, foreColor, backColor, borderColor)

Where
- strTitle refers to the new title.
- iPos refers to the position of  the title within the applet; the range of  
value is the same as that of  the element titlePos.
- foreColor refers to the text color in hexadecimal format rrggbb.
- backColor refers to the background color of  the title in hexadecimal 
format rrggbb.
- borderColor refers to the color of  the border in hexadecimal format 
aarrggbb.

Tips:
Set the iPos, foreColor, backColor and borderColor with a value of ‘-1’ to use the default setting or the 
setting defined by the elements.
This method works in line with the TransitTo() method. When you transit to a new Scene, you will need to 
use this method to change the title or else the title will remain the same as the one defined by the element 
title. For the PixScreen applet, it is not necessary to use this method depending on preference. This is 
because the title will change based on the definition defined in the world element.

Example

<a href=”#” onClick=”document.applets[0].SetTitle(‘Lobby’, 3, -1, -1, -
1)”)>Lobby</a>

Set the title to ‘Lobby’ and display it at the right bottom corner of  the applet 
using the default colors for the foreground, background and border.
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CBard.class

This applet enables instant story telling with ease. It displays a story line that 
changes between Scenes when the user clicks on the Hotspots within the 
Scene or clicks on the hyperlinks created with TransitTo() methods. The story 
description is taken from the story definition defined in the world parameter.

Syntax
<applet name=”myBard” code=”CBard.class” height=40 id=SceneStory 
width=400 archive=”PixScreen.jar”>
                  <param name=backgroundColor value=”FFFFFF”>
                  <param name=fontSize value=10>
</applet>

Where
- height refers to the display height of  the story panel. PixMaker Pro sets  
 it at ‘40’ pixels. It should be increased proportionally with the length  
 of  the story description.
- width refers to the display width of  the story panel. PixMaker Pro  
 sets it at ‘400’ pixels. At ‘400’ pixels, it can only accommodate  
 sentences with 53 characters or less. It should be increased   
 proportionally with the length of  the story description.

Presently, you can only change the story panel’s background color and font size. 
You can include other attributes that are standard for the <applet> definition. 
For example, spacing between the applet and the surrounding content within the 
webpage using the hspace and vspace attributes.
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